
Škoda Scala
CenCenník (platnník (platný od 10.12. do 31.12.2024 s DPH 20%)ý od 10.12. do 31.12.2024 s DPH 20%)

*Dostupné už len skladové zásoby

Zistite viac

Motor PalivPalivoo PrPreevvodoodovkavka PohonPohon Essence Selection Top Selection* Monte Carlo

1.0 TSI 70kW (95k) Benzín 5° MP predný 18 730 20 340 22 760 24 160
1.0 TSI 85kW (116k) Benzín 6° MP predný 19 850 21 400 23 820 25 210
1.0 TSI 85kW (116k) Benzín 7° AP DSG predný 21 770 23 440 25 860 27 260
1.5 TSI 110kW (150k) Benzín 6° MP predný - 22 870 25 290 26 690
1.5 TSI 110kW (150k) Benzín 7° AP DSG predný - 24 930 27 350 28 750
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Prečo práve Scala?

Kompaktná zvonku

Kompaktné rozmery vozidla prídu vhod pri každodennom
dochádzaní do práce a zariaďovaní ďalších povinností. Ľahko
zaparkujete aj v obmedzenom priestore a pri tom môžu pomôcť
predné aj zadné parkovacie senzory alebo zadná parkovacia kamera.

Veľká zvnútra

Priestranný interiér vyhovie nárokom celej rodiny a batožinový
priestor s objemom 467 litrov pojme prekvapivo mnoho vecí. Chytré
detaily v podobe háčikov na tašky, sieťového programu a ďalších
vylepšení si nebudete môcť vynachváliť.

Špičková výbava

Full LED Matrix predné svetlomety, elektricky odistiteľné a sklopné
ťažné zariadenie alebo vyhrievané čelné sklo sú len výberom zo
špičkových prvkov výbavy, ktoré si môžete vo svojej Scale dopriať.

Športová verzia

Pre motoristických fajnšmekrov máme pripravenú športovú verziu
Monte Carlo. Dizajnové detaily v lesklej čiernej farbe a špecifické
kolesá spestrujú vonkajší dizajn vozidla, zatiaľ čo vnútri sa budete cítiť
ako v športovom vozidle vďaka športovým predným sedadlám,
športovému trojramennému volantu, krytom pedálov z ušľachtilej
ocele a čiernemu stropu s panoramatickou strechou.

Vyberte si svoj interiér

Loft Lodge

Suite Dynamic
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Základná výbava

Interiér Studio

Airbag vodiča a spolujazdca, airbag spolujazdca s deaktiváciou

Hlavové airbagy a bočné airbagy vpredu

ESC vrátane ABS, EBV, MSR, ASR, EDS, HBA, DSR, ESBS, XDS+,
TPM, multikolíznej brzdy (MKB) a funkcie Prefill

Front Assist - výstraha pred kolíziou a podpora núdzového brzdenia
a Pederstrian Monitor (ochrana chodcov)

Easy Light Assist – svetelný senzor

Lane Assist – asistent udržiavania v jazdnom pruhu

ISOFIX na sedadle spolujazdca

3. hlavová opierka vzadu

Centrálne zamykanie s diaľkovým ovládaním, 2 sklopné kľúče

Full LED predné svetlomety

Oceľové disky kolies 6J × 16" s krytmi Tecton

Brzdy kotúčové (predné aj zadné)

Virtuálny kokpit 8"

Čítanie dopravných značiek

2-ramenný PUR volant

Obmedzovač rýchlosti

Infotainment Škoda s 8" displejom a 2x USB-C vpredu

eCall, CareConnect na 3 roky

Bluetooth

Manuálna klimatizácia s peľovým filtrom

Výškovo nastaviteľné sedadlo vodiča

Zadné parkovacie senzory

Driver Alert - asistent rozpoznania únavy

Elektricky ovládané a vyhrievané vonkajšie spätné zrkadlá

Vonkajšie spätné zrkadlá a kľučky dverí lakované vo farbe karosérie

Elektrické ovládanie okien vpredu

Asistent rozjazdu do kopca (iba pre AP)

Paket Simply Clever: háčiky na tašky – pevné, nesklopné, odkladacia
schránka – na strane za podbehom, uchytávacie klipy pre sieťový
program, sieťový program, 12V zásuvka v batožinovom priestore

Sada na opravu pneumatík

Predĺžená záruka na 5 rokov/100 000 km
(Platí tá z podmienok, ktorá nastane skôr, prvé 2 roky bez
obmedzenia počtu kilometrov)

Premenlivý servisný interval s výmenou oleja až 30 000 km alebo
každé 2 roky

Škoda – Doživotná Garancia Mobility Premium
Poskytuje pomoc servisným vozidlom na mieste poruchy (porucha
na vozidle, chýbajúce PHM, defekt pneumatiky, zabuchnuté/stratené
kľúče, vybitá batéria, zámena paliva), odtiahnutie vozidla, prípadne
služby – náhradnú dopravu, požičanie náhradného vozidla,
ubytovanie pre posádku a i.

Interiér Loft

Asistent rozjazdu do kopca

Disky Nyota z ľahkej zliatiny 6J × 16" – strieborné

Predné hmlové svetlá

2-ramenný multifunkčný kožený volant (pre AP s podvolantovým
ovládaním DSG)

Easy Start – bezkľúčové štartovanie

Tempomat

Lakťová opierka s JumboBox

2× USB vzadu (typ C len na nabíjanie)

Bezdrôtový Smartlink

Ďalšie 4 reproduktory vzadu

Vnútorné spätné zrkadlo s automatickým stmavovaním

Elektrické ovládanie okien vzadu

Climatronic – dvojzónová automatická klimatizácia so senzorom
vlhkosti a kombi filtrom

Vyhrievanie predných sedadiel

Výškovo nastaviteľné sedadlo vodiča a spolujazdca

Ukazovateľ stavu kvapaliny v ostrekovači

Dáždnik

Interiér Lodge

Dažďový senzor

KESSY - bezkľúčové odomykanie, zamykanie a štartovanie

Alarm

Full LED Matrix predné sveltomety

Predné hmlové svetlá s corner funkciou

Full LED zadné svetlá s dynamickým ukazovateľom smeru

Disky z ľahkej zliatiny Stratos 6,5J x 17"

2-ramenný multifunkčný kožený vyhrievaný volant (pre AP
s podvolantovým ovládaním DSG)

Ambientné osvetlenie prepínateľné biela/červená

USB-C vo vnútornom spätnom zrkadle

Zadná lakťová opierka

Predné a zadné parkovacie senzory

Driving Mode Select

Zadná parkovacia kamera

Sunset

Podokenná chrómová lišta

Elektricky sklopné, ovládané a vyhrievané vonkajšie spätné zrkadlá
s automatickým stmievaním na strane vodiča

Phonebox

Vkladané tkané koberce vpredu a vzadu

Essence

Selection (navyše oproti Essence)

Top Selection (navyše oproti Selection)
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Základná výbava

Interiér Monte Carlo

Dažďový senzor

KESSY - bezkľúčové odomykanie, zamykanie a štartovanie

Full LED Matrix predné sveltomety

Predné hmlové svetlá s corner funkciou

Full LED zadné svetlá s dynamickým ukazovateľom smeru

Predĺžené sklo 5 dverí a panoramatická strecha

Čierny strop

Disky Kajam Aero z ľahkej zliatiny 6,5J × 17" – čierne

Kryty pedálov z ušľachtilej ocele

3-ramenný vyhrievaný multifunkčný kožený volant (pre AP
s podvolantovým ovládaním DSG)

Ambietné osvetlenie prepínateľné biela/červená

Zadná lakťová opierka

Predné a zadné parkovacie senzory

Driving Mode Select

Zadná parkovacia kamera

Sunset

Elektricky sklopné, ovládané a vyhrievané vonkajšie spätné zrkadlá

Vkladané tkané koberce vpredu a vzadu

Doplnková výbava

Essence Plus › Elektricky ovládané zadné okná
› Výškovo nastaviteľné sedadlo spolujazdca
› Predné hmlové svetlá
› Tempomat
› Vkladané tkané koberce vpredu a vzadu

WIL 531

Light & View › Dažďový senzor
› Full LED zadné svetlá s dynamickým

ukazovateľom smeru
› Predné hmlové svetlá s corner funkciou
› Elektricky sklopné vonkajšie spätné zrkadlá

s automatickým stmievaním na strane vodiča
› Vnútorné spätné zrkadlo s automatickým

stmavovaním (iba pre Essence)
› Elektrické ovládanie okien vzadu (iba

pre Essence)
(WYH platí len pre Selection iba v kombinácii
s WIS/WI2/PMA)
(WYH nie je možné s PYB)

WIH/WYH 831 463 • •

Light & View Plus › Naviac oproti Light & View
› Full LED Matrix predné svetlomety

(WYI platí iba v kombinácii s WIS/WI2/PMA)

WII/WYI − 1247 • •

Monte Carlo (navyše oproti Selection)

Essence Selection Top Selection Monte CarloAkčné pakety

Essence Selection Top Selection Monte CarloBezpečnosť
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Adaptive Cruise Control - adaptívny tempomat do 210km/h PC5 − 473 473 473

Assisted Drive › Adaptive Cruise Control - adaptívny
tempomat do 210km/h

› Adaptive Lane Assist

PIA − 646 646 646

Assisted Drive Plus › Naviac oproti Assisted Drive
› Side Assist
› Dažďový senzor
› Full LED zadné svetlá s dynamickým

ukazovateľom smeru
› Predné hmlové svetlá s corner funkciou
› Elektricky sklopné vonkajšie spätné zrkadlá

(PYB platí pre Selection iba v kombinácii
s WIS/WI2/PMA a Top Selection)

PIB/PYB − 1298 834 834

Safety › Crew Protect Assist – proaktívna ochrana
cestujúcich

› Kolenný airbag vodiča
› Bočné airbagy vzadu

WIX − 526 526 526

Deliaca sieťová stena 3CX 122 122 122 122

Medzipodlaha batožinového priestoru 3GD 175 175 175 175

Simply Clever Plus › Sieťový program
› Odkladací priestor pod prednými sedadlami
› Ochrana hrán bočných dverí
› Obojstranný koberec v batožinovom priestore
› Odpadkový kôš
› Odkladací priestor s flexibilným držiakom

na zadnom tuneli
› Držiak na tablet a telefón

(nie je možné s PWA/WQ7)

PIK 270 270 270 270

Simply Clever Plus
(pre elektricky ovládané
sedadlo vodiča)

› Sieťový program
› Ochrana hrán bočných dverí
› Obojstranný koberec v batožinovom priestore
› Odpadkový kôš
› Odkladací priestor s flexibilným držiakom

na zadnom tuneli
› Držiak na tablet a telefón

(možné len s PWA/WQ7)

PI2 − 234 234 234

Príprava na ťažné zariadenie 1D7 209 209 209 209

Ťažné zariadenie – sklopné 1M6 982 982 982 982

Adaptér pre ťažné zariadenie ND1 39 39 39 39

Ostrekovače svetlometov 8X1 151 151 151 151

Interiér Lodge › Láťkové sedadlá Lodge
› Ambientné osvetlenie červené /biele
› Sivý poťah prístrojovej dosky
› Medené orámovanie výduchov ventilácie
› Zadná ľakťová opierka
› Vkladané tkané koberce vpredu a vzadu

(iba s interiérom HP/HQ)

WQ3 − 434 • −

Interiér Dynamic › Športové sedadlá
› Čierny strop
› 3-ramenný kožený športový multifunkčný

volant (pre AP s podovlantovým ovládaním
DSG)

› Ambientné osvetlenie červené /biele
› Čierny poťah prístrojovej dosky
› Červené orámovanie výduchov ventilácie
› Kryty pedálov z ušľachtilej ocele
› Zadná ľakťová opierka
› Vkladané tkané koberce vpredu a vzadu
› Prahové lišty s názvom Scala

(iba s interiérom AH)

WQ4 − 965 − −

Essence Selection Top Selection Monte CarloBezpečnosť

Essence Selection Top Selection Monte CarloFunkčnosť

Essence Selection Top Selection Monte CarloVolanty / interiéry / sedadlá
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Interiér Suite › Poťah sedadiel Suedia /koža /umelá koža
› Čierny poťah prístrojovej dosky
› Chrómové orámovanie výduchov ventilácie
› Zadná ľakťová opierka
› Elektricky nastaviteľné sedadlo vodiča
› Ambientné osvetlenie červené /biele
› Vkladané tkané koberce vpredu a vzadu
› Prahové lišty s názvom Scala

(iba s interiérom JG/JI)

WQ7 − 1585 − −

Elektricky nastaviteľné sedadlo vodiča (možné len s WQ3/WQ4, nie je
možné s PIK)

PWA − 483 483 483

2-ramenný kožený multifunkčný volant (možné len s WIL) PLC 363 • − −

2-ramenný kožený vyhrievaný multifunkčný volant PLE − 105 • −

3-ramenný kožený vyhrievaný športový multifunkčný volant PLM − 238 238 −

2-ramenný kožený vyhrievaný multifunkčný volant pre DSG PLG − 105 • −

3-ramenný kožený vyhrievaný športový multifunkčný volant pre DSG PLP − 238 238 −

3-ramenný kožený športový multifunkčný volant PLK − 134 − −

3-ramenný kožený športový multifunkčný volant pre DSG PLN − 134 − −

Disky z ľahkej zliatiny Cortadero Aero 6J x 16" (205/55) P02 617 0 − −

Disky z ľahkej zliatiny Nyota 6J x 16" (205/55) P06 696 • − −

Disky z ľahkej zliatiny Montado Aero 6J x 16" – čierne (205/55) P08 835 139 − −

Disky z ľahkej zliatiny Kajam 6,5J x 17" (205/50) PJG − 584 38 −

Disky z ľahkej zliatiny Stratos 6,5J x 17" (205/50) PJP − 545 • −

Disky z ľahkej zliatiny Propus Aero 6,5J x 17" – čierne (205/50) PJR − 684 139 −

Disky z ľahkej zliatiny Ursa Aero 7J x 18" – čierne (205/45) P20 − 1189 643 −

Disky z ľahkej zliatiny Fornax 7J x 18" – strieborné (205/45) PJN − 1148 603 −

Disky z ľahkej zliatiny Vega Aero 7J x 18" – čierne (205/45) PJV − 1289 744 −

Disky z ľahkej zliatiny Ursa 7J x 18" – čierne (205/45) PJI − − − 564

Rezerva na oceľovom disku (neplnohodnotná), zdvihák, kľúč na kolesá PJA 122 122 122 122

Winter › Vyhrievané predné sedadlá
› Ukazovateľ stavu kvapaliny v ostrekovači

WIC 233 • • −

Winter Premium › Vyhrievané čelné sklo
(možné len s PLG/PLP/PLE/PLM)
(nie je možné s 4A4)

WIE − 146 − 146

Winter Premium &
Technology Plus

› Vyhrievané čelné sklo
› Phonebox bez LTE
› USB-C vo vnútornom spätnom zrkadle

(možné len s PLG/PLP/PLE/PLM)
(nie je možné s 4A4)
(WI3 platí pre Monte Carlo)

PMA/WI3 − 342 146 342

Paket pre zlé cesty (zvýšený podvozok o 15 mm, dodatočná ochrana
podvozka)

PZP 151 151 151 −

Vyhrievané zadné sedadlá (nie je možné s WIE/PMA/WI3) 4A4 − 187 187 187

Drive › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie

a štartovanie
› Čierne lakované spätné zrkadlá a predná

maska
› 10" Virtuálny kokpit
› Sunset
› Sport Chassis Control–podvozok

s nastaviteľnou tuhosťou tlmičov
› Drive Mode Select

(možné len s P08/PJV/PJR)

PKS − 1208 − 610

Essence Selection Top Selection Monte CarloVolanty / interiéry / sedadlá

Essence Selection Top Selection Monte CarloDisky / pneumatiky

Essence Selection Top Selection Monte CarloKomfort
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Drive so Safe › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie

a štartovanie
› Alarm
› Čierne lakované spätné zrkadlá a predná

maska
› 10" Virtuálny kokpit
› Sunset
› Sport Chassis Control–podvozok

s nastaviteľnou tuhosťou tlmičov
› Drive Mode Select

(možné len s P08/PJV/PJR)

PKW − 1458 670 825

Sunset 4KF − 170 • •

Chrome paket › Sunset
› Podokenná chromová lišta

PIF − 309 • −

Image paket › Predĺžené sklo piatych dverí
› Spojler
› Sunset

PIU − 342 229 •

Emotion paket › Naviac oproti Image:
› Panoramatická strecha
› Čierny strop
› Bez schránky na okuliare)

(možné len s interiérmi HO/HQ/JI/AH)

WIV − 1175 1065 •

Predné parkovacie senzory 7X2 − 358 • •

Zadná parkovacia kamera KA2 − 398 • •

Convenience so safe › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie

a štartovanie
› Drive Mode Select
› Predné parkovacie senzory
› Alarm

WJM − 979 • 247

Convenience Plus so safe › Naviac oproti Convenience so safe
› Elektricky ovládané piate dvere s virtuálnym

pedálom
› 10" Virtuálny kokpit

WJN − 1640 661 916

Convenience Premium so
safe

› Naviac oproti Convenience Plus so safe
› Parkovací asistent

(PYC platí pre Top Selection)

WJO/PYC − 1761 782 1086

Convenience bez safe › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie

a štartovanie
› Drive Mode Select
› Predné parkovacie senzory

WIM − 745 − •

Convenience Plus bez safe › Naviac oproti Convenience bez safe
› Elektricky ovládané piate dvere s virtuálnym

pedálom
› 10" Virtuálny kokpit

WIN − 1403 − 707

Convenience Premium
bez safe

› Naviac oproti Convenience Plus bez safe
› Parkovací asistent

WIO − 1524 − 878

Technology › 4 reproduktory vzadu
› Bezdrôtový Smartlink
› Lakťová opierka s JumboBox
› 2x USB -C vzadu

WIQ 561 • • −

Technology Plus › Phonebox bez LTE
› USB-C vo vnútornom spätnom zrkadle

(WI2 iba v kombinácii s PLG/PLP/PLE/PLM)

WIS/WI2 − 196 • 283

Navi paket › 9.2" Škoda Navigation
› 10" Virtuálny kokpit
› Web Rádio
› Hlasové ovládanie
› Infotainment Online na 3 roky

WIT − 1241 1241 1241

Sound System Škoda, rezervné koleso (dojazdové), zdvihák + klúč na kolesá
(možné len s WIT a WQ3/WQ4/WQ7)

PJC − 643 643 643

Essence Selection Top Selection Monte CarloKomfort

Essence Selection Top Selection Monte CarloMultimédiá
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Alarm PD1/PD3 269 269 • −

• Základná výbava − Nie je v ponuke MPManuálna prevodovka AP Automatická prevodovka

Modrá Energy *UNI 0 0 0 0

Biela Candy *SPE 398 398 398 398

Metalické farby, Sivá Steel *MET 572 572 572 572

Červená Velvet *FLT 1009 1009 1009 1009

Predĺžená záruka na 5 rokov/100 000km EA4 0 0 0 0

Predĺžená záruka na 5 rokov/150 000km EA9 200 200 200 200

Servis 5 rokov/75 000 km 798 1518

Servis 5 rokov/100 000 km 1020 2124

Servis 5 rokov/150 000 km 1488 3354

Essence Selection Top Selection Monte CarloZabezpečenie vozidla

Essence Selection Top Selection Monte CarloOstatné

Basic ProfessionalServisné balíčky
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Ponuka farieb a diskov

Červená Velvet, metalická Čierna Magic, metalická Modrá Race, metalická Biela Moon, metalická

Strieborná Brilliant, metalická Sivá Graphite, metalická Modrá Energy, uni Sivá Steel, uni

Biela Candy, uni

Oceľové disky 16"
s krytmi Tecton

Cortadero Aero 16"
strieborné

Nyota 16"
strieborné

Montado Aero 16"
čierne

Kajam 17"
strieborné

s aero krytmi

Stratos 17"
strieborné

Propus Aero 17"
čierne

Ursa Aero 18"
strieborné

s aero krytmi

Fornax 18"
strieborné

Vega Aero 18"
čierne

s aero krytmi

Kajam 17"
čierne

s aero krytmi

Ursa 18"
čierne
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Poznámky

Technické dáta vozidla nájdete v katalógu technických dát na stránke www.skoda-auto.sk.
Ceny uvedené v cenníku sú odporúčané ceny pre klienta v € vrátane DPH 20%.
Doplnková výbava znamená bohatšie vybavenie vozidla, nie zdvojenú výbavu. Konečnú cenu, výbavu a jej
možnú kombinovateľnosť konzultujte s autorizovaným predajcom značky Škoda.
Spoločnosť Škoda Auto Slovensko s. r. o. si vyhradzuje právo zmeny cien a špecifikácií
bez predchádzajúceho upozornenia. Všetky obrázky sú ilustračné.

Cenník platný od 10.12.2024 (MR2025)

Spoločnosť Škoda Auto sa usiluje o zodpovedný, trvale udržateľný vývoj spoločnosti a šetrný prístup k životu a prírode.

Váš autorizovaný partner značky Škoda
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